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We aim to develop and produce the best solution for your application
in the field of optical measurement technique. To help us to live up to
your expectations and constantly improve our products we need
your ideas and suggestions. Therefore, please let us know about
possible criticism or ideas. We and our international partners are
looking forward to hearing from you.

Thorlabs GmbH

  Warning  

Sections marked by this symbol explain dangers that might result in
personal injury or death. Always read the associated information
carefully, before performing the indicated procedure.

Please read this advice carefully!

This manual also contains "NOTES" and "HINTS" written in this form.

  Attention  

Paragraphs preceded by this symbol explain hazards that could
damage the instrument and the connected equipment or may cause
loss of data.

  Note  

3
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Optical Power Monitor

1   General Information
The Thorlabs Optical Power Monitor (OPM) is a graphical user interface (GUI) designed for the
straightforward use of Thorlabs' power meters. The OPM monitors and saves power meter
measurements and features an interface for data viewing and analysis. A variety of setting for
the connected devices, the display, and the measurement can be easily configured.

To control complex setups, the OPM can monitor up to 8 Thorlabs power meters in parallel,
connected via USB or Bluetooth also on your tablet computer. 

The OPM software provides continuous data logging, also for long-term measurements. Short-
term measurements are monitored and recorded by the software with a high resolution.

The user can switch between displayed parameters at any time during an active measurement
or use the simulated analog needle view for assistance during tuning.

Log files saved by the OPM or data saved by a PM400 power meter can be loaded into the
OPM Data Viewer for viewing or analysis. Additionally, the OPM provides statistics parameters
to evaluate the results. 

The user can set the display language to English, German, or Chinese.

Beyond these capabilities, the OPM provides a user-friendly design with reduced overall bright-
ness for comfortable work in dark environments and high contrast and minimized use of color
coding for operability with laser safety glasses. 

The OPM supports the following Thorlabs power meters and appropriate sensors and can ad-
minister them in parallel. 

· PM100USB
· PM16-Series
· PM160 1) 
· PM160T 1) 
· PM160T-HP 1) 
· PM400
· PM100A
· PM100D
· PM200

 1) Bluetooth connection possible

 Note 

The OPM contains the functions provided by the Optical Power Meter Utility, Multi Power
Meter, and Power Meter Monitor software packages and provides many additional features.

 Attention 

New Instrument Driver

Please note that the Optical Power Monitor installs and uses new and improved instrument
drivers. In case you want to use any of the old software packages Optical Power Meter Utility,
Multi Power Meter or Power Meter Monitor or if you are using Custom Made Software,
please read the Instrument Driver for Thorlabs Power Meters section.

https://www.thorlabs.com/newgrouppage9.cfm?objectgroup_id=4037&pn=PM100USB#8135
https://www.thorlabs.com/newgrouppage9.cfm?objectgroup_id=9005
https://www.thorlabs.com/newgrouppage9.cfm?objectgroup_id=7233&pn=PM160#7267
https://www.thorlabs.com/newgrouppage9.cfm?objectgroup_id=7233&pn=PM160T#7651
https://www.thorlabs.com/thorproduct.cfm?partnumber=PM160T-HP
https://www.thorlabs.com/newgrouppage9.cfm?objectgroup_id=10562&pn=PM400#10566
https://www.thorlabs.com/newgrouppage9.cfm?objectgroup_id=3422&pn=PM100A#8149
https://www.thorlabs.com/newgrouppage9.cfm?objectgroup_id=3341&pn=PM100D#5080
https://www.thorlabs.com/newgrouppage9.cfm?objectgroup_id=5386&pn=PM200#5387
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2   Requirements
These are the requirements for the PC intended to be used for the installation of the Optical
Power Monitor.

Hardware Requirements

CPU: 2.4 GHz or Faster

RAM: Min. 4 GB

Graphic Card: Min. 1024x768 Pixel Graphic Resolution

Hard Disc: Min. 1 GB of Available Free Space (32 bit Operating System)
Min. 2.3 GB of Available Free Space (64 bit Operating System)

Interface Free USB 2.0 Port, USB Cable According to the USB 2.0 Specification

Software Requirements

The OPM software is compatible with the following operating systems:

· Windows® 7 (SP1+) (32-bit, 64-bit) 

· Windows® 8.1 (32-bit, 64-bit) 

· Windows® 10 (32-bit, 64-bit) 

For operation of the Optical Power Monitor, the following software is required:

· Microsoft® .Net (Version 4.6.1 or later) 

· DirectX9® or higher 
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3   First Steps
The Optical Power Monitor can be downloaded from the Thorlabs website:

https://www.thorlabs.com/software_pages/ViewSoftwarePage.cfm?Code=OPM

 Note 

Do not connect a power meter to the PC during software installation! Please make sure that the
installation is carried out completely, including the reboot requests. This is essential for proper
operation.

· Save the ZIP file to your computer and unpack the archive. 
· Double click the setup.exe to install Shield Wizard. 
· Read and accept the End-user License Agreement and the GNU Lesser general Public Li-

cense. 
· Note the Readme Information during the installation process: A new and improved instrument

driver (TLPM Instrument Driver) is installed.
· After installing the OPM, connect the USB cable of your power meter(s) to the PC.

 Note 

Up to 8 power meters can be connected and monitored in parallel in a single software instance.
If your PC does not provide a sufficient number of USB-ports, use a powered USB-HUB and
ensure that enough power is supplied to the power meters. 

Start Application

Start the OPM from the desktop icon:

or access the OPM from the START button:

 Attention 

New Instrument Driver

Please note that the Optical Power Monitor installs and uses new and improved instrument
drivers. In case you want to use any of the old software packages Optical Power Meter Utility,
Multi Power Meter or Power Meter Monitor or if you are using Custom Made Software,
please read the Instrument Driver for Thorlabs Power Meters section.

 Note 

When connecting an additional power meter, unknown to the PC, the driver for this power
meter will be installed as indicated on the bottom right corner of the screen. 

https://www.thorlabs.com/software_pages/ViewSoftwarePage.cfm?Code=PM100x
https://www.thorlabs.com/software_pages/ViewSoftwarePage.cfm?Code=OPM
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4   Graphical User Interface (GUI)
After starting the OPM and connecting a power meter to the PC, the default GUI window opens.

In this manual, the OPM interface is described based on a set up using a Power Meter Device
consisting of a Thorlabs PM100USB with a Thorlabs Photodiode Power Sensor S120C, con-
nected to a PC running with OS Windows® 7. Variations in the interface due to different power
meter consoles are described in the section OPM with Different Devices. 

The OPM automatically connects the first recognized power meter and lists it in Active Devices
(here: PM100USB).

  

Menu Bar

File Load File, Save, and Print Screen Shot and Exit the Software

Devices Activate and Administer Devices and Measurements

Monitoring Set Up a Measurement to be Logged and Saved (Active only after Device
Setup)

Data Viewer View and Analyze Loaded Files 

Help General Software Settings, Software Information and Link to the Manual

To setup a short measurement, go through the sub menu of Devices or use the Monitoring
menu for long term logging.  

https://www.thorlabs.com/newgrouppage9.cfm?objectgroup_id=3328&pn=S120VC#3329
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 Note 

If no power meters are connected to the PC or automatically recognized, the OPM starts with
the Found Devices panel instead of the Measurement panel. Use the Found Devices panel to
scan for devices and connect them to the software. 

 Note 

The user can now adjust the preferred display language in the HELP menu.

4.1   File

The File menu provides the following options: 

Load Files Generated in Monitoring

Load Files Generated by the Thorlabs PM400 

Print a Screen Shot

Generate a Screen Shot to be Saved as an Image

Close the OPM

 Note 

The file structure of data saved by the Optical Power Monitor and the PM400 differ. Both file
formats can be loaded by the OPM by selecting the appropriate import option. Also note the in-
formation given in the section file formats.

4.2   Devices

The Devices menu administers the currently connected devices, short-term measurements and
the respective settings. 

To start a measurement, follow the sequence suggested by the menu bar from left to right: 

· Activate Devices 
· Adjust Settings
· Observe the Measurement 



© 2018 Thorlabs GmbH

4 Graphical User Interface (GUI)

9

Menu Bar

Active Devices Administer Connected Power Meters

Settings Administer Settings of the Display and Connected Devices

Information Information about the Connected Devices

Measurement Active Measurement Display

Tuning Analog Needle Simulation with Digital Measurement Value

Statistics Statistics Tool to Setup, Display, and Save Statistics of the Active Meas-
urement

Graph Tool for Short-Term Measurements with High Sampling Resolution

 Note 

If no power meters are connected to the PC or automatically recognized, the OPM starts with
the Found Devices panel instead of the Measurement panel. Use Found Devices to scan for
devices and connect them to the software. The OPM automatically connects the first recog-
nized power meter. 
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4.2.1   Active Devices

To monitor power meters, the devices need to be activated in the Found Devices panel. The
OPM automatically recognizes devices connected to the PC and connects to the first recog-
nized device any time the software is started. Connected devices appear in the list Active
Devices.

In the example below, the PM100USB and a sensor with the Serial Number 14031917 are con-
nected to the PC. This combination has automatically been connected to the OPM and there-
fore appears in the panel Active Devices.

Active devices receive a default name consisting of the power meter type and the serial number
of the sensor. This default name can be edited to a name of choice.

 Note 

Devices that were connected to the software in the previous session are automatically recon-
nected to the software. In that case, device name and settings from the previous session are
automatically loaded in the new session. 

Use the Tool Bar, to add or edit the active devices:

 : Add devices to the list of Active Devices

: Edit: Rename devices or Disconnect devices from the software

 Note 

In case a device was not recognized by the Optical Power Monitor, please reconnect it to the
PC.

4.2.1.1  Add Devices

Use the Found Devices panel to connect power meter consoles to the software by activating
them in the "Active Devices" list.

· Click  in the Active Devices table to add devices.

· Click Rescan if no devices are detected to find all devices connected to the PC or reconnect
devices to the PC.
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Here, PM100USB, PM160 and PM160T are recognized. The first recognized device (here:
PM100USB) is automatically connected to the software.

The panel Found Devices shows details about the devices that are connected to the PC. 

Click  to view sensor information.

· Mark the tick-box in Found Devices and click Connect to activate devices.

· Click on a device in Active Devices to return to the Devices menu and view measurements.

 Note 

When the first recognized device is connected to the software, the display changes to monitor a
measurement as shown in Devices.

 Note 

If no power meters are connected to the PC or automatically recognized, the OPM starts with
the Found Devices panel.
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 Attention 

Devices with Incompatible Instrument Driver

Recognized devices that are using an incompatible instrument driver are listed on the bottom of
the Found Devices panel.

This is because the Thorlabs Optical Power Monitor uses a different driver for the connected
power meters than former Thorlabs Power Meter software applications. For information on

which driver to choose, click for information or read the section Instrument Driver for Thorlabs
Power Meters in this manual. 

To use the devices now listed with an incompatible driver, click Open Power Meter Driver
Switcher.

 Attention 

You need administrator rights on your PC to use the Power Meter Driver Switcher and change
instrument drivers.

 Attention 

For customers who wish to keep using the Power Meter Monitor, Optical Power Meter Utility
or Multi Power Meter software or who are using Custom Made Software, please read the
section Instrument Driver for Thorlabs Power Meters to adjust driver or software.
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4.2.1.2  Edit Devices

Click  to edit the Active Devices list. 

  : Rename the device to describe its function in the experimental setup 

Disconnect: Remove the device from the list of Active Devices

The order of the list Active Devices can be changed by Drag-and-Drop.
 : Closes editing options and prevents unintentional editing.

4.2.2   Settings

Device settings and measurement settings need to be adjusted in the Settings menu prior to
the measurement by using the drop down menus shown below.

 Note 

Changes in the settings made during a measurement are applied immediately and impact the
measurement. Changes in settings during active measurements are not saved!

 Attention 

As the OPM calculations depend on these settings, correct settings are essential for best
measurement accuracy.

Display: Adjust Display Settings

Device: Adjust Device Settings

Beam Parameters: Adjust Light Source Settings

Display

Parameter: Select the parameter that should be displayed as the main
parameter in all 4 measurement monitors: Measurement, Tuning, Statist-
ics, and Graph. 

Resolution: Set the desired measurement resolution.
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Device

Wavelength: Set the wavelength of the measured light. This is essential in
order to compensate the measurement result for the wavelength-depend-
ent responsivity of the sensor.

Bandwidth: Set the bandwidth of the photodiode to low or high, depend-
ing on the incoming signal and the properties of your photodiode sensor
(please see the specification of your sensor and the Thorlabs Photodiode
Tutorial). 

Range: Maximum value to be measured within the selected power range.
This displayed value is calculated by the power meter. It is recommended
to use the default setting Auto Range ON.

Use Auto Range OFF, to set the measurement range manually, for ex-
ample for measurement of pulsed light sources.

Attenuation: To account for the attenuation of optical components placed
between the light source and the power meter sensor (e.g. filters, beam
splitters, etc.), a correction factor can be assigned. For exceptions see the
section Power Meter Dependent Variations. 

Zero Adjust: Compensate the measurement result for the measured dark
signal or noise.

Averaging: Choose the number of values averaged. Averaging is calculated by the software
and thus the measurement values may differ from the values displayed on the power meter
consoles. Measurement values are provided to the software by the connected Thorlabs power
meter at the specified refresh rate described in the power meter manual. When choosing to av-
erage the measurement values, all measurement values displayed within the OPM will be aver-
aged.

 Note 

Depending on the power meter, not all options may be displayed. 

Beam Parameters

The Beam Parameters are relevant when calculating Irradiance or Fluence. 

Shape: Choose between Circular, Square or Rectangular according to
your light source and optics.

Size: Adjust the size of the beam arriving on the photo sensor according to
your light source and optics.

Profile: Adjust beam profile arriving at the photo sensor according to your
light source and optics.

https://www.thorlabs.com/tutorials.cfm?tabID=787382ff-26eb-4a7e-b021-bf65c5bf164b
https://www.thorlabs.com/tutorials.cfm?tabID=787382ff-26eb-4a7e-b021-bf65c5bf164b
https://www.thorlabs.com/search/thorsearch.cfm?search=power%20meter
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4.2.3   Information

This menu lists information about the connected devices, Power Meters and Sensors, as re-
trieved from the connected device.

Power Meter

Type: Type of Thorlabs Power Meter

Serial Number: Serial Number of the Device

Calibrated: Date of Last Calibration

Firmware Revision: Current Firmware Version of the Power Meter

Sensor

Name: Sensor Name

Serial Number: Serial Number of the Sensor

Calibration: Date of Last Calibration

Type: Type of Sensor: Photodiode, Thermal-, or Pyroelectric
Sensor 

Wavelength Range: Wavelength Range of Detection of the Sensor

4.2.4   Measurement

In the measurement panel, the currently measured numerical values of selected parameters
are displayed. Use the Tool Bar to add more parameters to the display, maximize the display
screen, or reset the measurement. 

The display resets when a different device is selected. 
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Tool Bar 

Add/Remove Parameter

Several numerical measurement values can be displayed simultaneously in the main screen.
To select the parameter of interest from the panel, click to open the following interface:

 Reset min/max: 

Click the icon to reset the displayed minimum and maximum values and recalculate their ratio.

Maximize the Screen: 

Switch to full screen mode. Only the main parameter and wavelength will appear on the dis-
play. 

 Bright/dark design:

When the screen is maximized, the user can
switch to dark design to reduce background
light in the maximized display. 

 Shrink: 

Reduce size of the display to view all selected
parameters.
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4.2.5   Tuning

This panel shows the analog needle simulation of the currently measured value along with the
digital numerical value.

The display can be adjusted using the Tool Bar. 
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 Enable/Disable Delta Mode

The Delta Mode shows the fluctuation around the measured value at the moment of starting the
delta mode. This value is reset to zero by clicking . 



© 2018 Thorlabs GmbH

4 Graphical User Interface (GUI)

19

View the Delta Mode in % by selecting the tick-box: Delta Mode (%) in the lower right display,
marked red.

Zoom in/out: The zoom-factor is determined by the current Min and Max-values.

 Reset min/max: Reset the displayed zero-, minimum and maximum values and recalculate
their ratio.
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4.2.6   Statistics

The Statistics panel shows the measurement statistics in chart and table format.

The chart displays the distribution of counts in percent for the parameter selected in Settings.
This parameter can be changed during the active measurement. When parameter or monitored
device are changed, the OPM starts a new data acquisition for statistical analysis. 

To configure, save, start and restart measurement statistics, use the Tool Bar. The Status Bar
below shows the currently measured values and the measurement progress.

Tool Bar

Statistics/Graph Settings

The number of data points used for statistics can be set as the duration of acquisition (Time) or
number of data points (Sample). These settings are also applied in the Graph panel for the dis-
play of power meter signal over time.
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 Note 

Statistics are calculated as a rolling average. After the set duration or number of samples is
reached, the next sample data point is evaluated at the expense of the first data point. Statist-
ics is shown even when the set sample number or measurement time is incomplete. 

Save Histogram Data

Saves a snapshot of the statistics. The file will be saved in .csv-format and can be opened in a
text editor. When the recording is stopped prior to full data acquisition as set in Statistics/Graph
setting, this incomplete set of data can be saved. 

 /  Stop/Start Collecting Data

Sampling for statistics can be stopped and restarted at any time. When the recording is
stopped prior to full data acquisition, this incomplete set of data is statistically evaluated and
can be saved. At START, the last set of acquired data is deleted.   

 Restart

Deletes the acquired statistics and graph mode data and starts a new acquisition for both, the
statistics and graph mode.

Status Bar

Most Recent Value: Most Recent Value Used for Statistics

Samples: Number of Samples Acquired for Statistics

Time: Duration of Acquisition for Statistics

Ratio: Ratio Between the Minimum and Maximum Values Recorded During
the Interval Set in Statistics/Graph Settings

Minimum: Lowest Value Recorded During the Interval Used for the Statistics
Calculation

Maximum: Highest Value Recorded During the Interval Used for the Statistics
Calculation

Mean: Mean Calculated Based on the Data Recorded During the Interval Set
in Statistics/Graph Settings

Standard Deviation: Standard Deviation Calculated Based on the Data Recorded During
the Interval Set in Statistics/Graph Settings
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4.2.7   Graph

The Graph panel displays the signal over time as measured by the power meter. Shorter power
meter measurements can be configured, flexibly displayed and saved, using the options given
in the Tool Bar. Use the Graph panel to acquire high-resolution measurements of over 100Hz,
depending on the refresh rate of the power meter. 

Data acquisition in Graph panel is reset when a different power meter is selected in the Active
Devices panel. 

Zoom: To zoom into the chart, place the mouse cursor over the diagram and scroll.

Tool Bar

Settings: Set the displayed time interval of the measurement in time or sample number.
These settings These settings are also applied in the Statistics panel
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Save graph data: Save a snap shot of the measurement in .csv format. When the
recording is stopped prior to full data acquisition as set in Statistics/Graph set-
tings, this incomplete set of data can be saved.

 /
 

Start/Pause collecting data: Sampling for the graph mode can be stopped and re-
started at any time. When the recording is stopped prior to full data acquisition, this
incomplete set of data is displayed and can be saved.

  
Restart: This deletes the acquired data in Graph mode and Statistics and starts a
new measurement and statistics evaluation.

 Zoom out: Zooms out to the original resolution in both, the X and Y axis. 

  Zoom out Y-Axis: Zooms out to the original resolution in the Y axis only. 

Zoom selection: Zooms into an area selected with the mouse. 

 Note 
In Graph mode, data are acquired in a rolling manner: After the set duration or number of
samples is reached, the next sample data point is inserted at the expense of the first data
point. 

Status Bar:

The status bar at the bottom shows the data acquisition progress with the following values

Most Recent Value: The value of the most recent data point collected in the time interval.

Samples: Number of samples acquired for the time interval set in Statistics/Graph settings .

Time: Recording time acquired for the display of the time interval set  in Statistics/Graph set-
tings .
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4.3   Monitoring

Use the Monitoring panel to configure, execute, observe, and save long-term monitoring of up
to 8 connected power meters in parallel and for different parameters. Long-term measurements
can be recorded with a minimal interval of one second. The Optical Power Monitor uses this
resolution in order to display data acquired from devices with different refresh rates in parallel.

To log a measurement, follow the sequence below:

1. Table Select the devices and parameters to be monitored. 

2. Logging Settings and
Logging Information

Select the settings for recording and saving of the measurement
and review settings in the Information panel. Start Logging.

3. Logging Chart Select the displayed parameters.
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4.3.1   Table Configuration

The Table menu lists the devices and parameters to be logged in the experiment and continu-
ously displays the currently measured values. To add devices and parameters to the table, use
the Tool Bar. 

 Configuration: Configure the devices and parameters to be monitored in the table, logged
in the measurement and displayed in the Logging Chart.

 + Add devices and parameters from the list of Deactivated Values to the Table Configura-
tion.

 x Remove Values by deselecting them in the left panel.

Choose a custom name for the device  in your setup. 
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The order of the selected values can be changed using the mouse. 

Click OK to return to the Table. 

The monitoring Table now lists the devices and parameters with their currently recorded data
that are logged in the experiment.

 Snapshot: Save a snapshot of the current values in .csv-format.

 Engineering Notation: Switch the table to engineering notation of the monitored values.

Following the selection of devices and parameters to be monitored, go to the Logging Configur-
ation menu. 

4.3.2   Logging Settings and Information

Configure the logging of a measurement and select the output file format, location and name
and set the duration and resolution for logging in the Settings menu.

Please read the section File Format to learn about the data saved in the log files.

Review the Logging Settings before beginning logging:
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Save as: Choose to save data either as single files or
multiple files, depending on the data volume. 

o Single files: The Optical Power Meter saves a .csv file
for short measurements with small data volume. 

oMultiple files: The Optical Power Meter saves multiple
.cvs files for longer measurements, measurements with
multiple power meters in parallel or large data volumes
of measurements taking more 3 days. When the soft-
ware saves multiple files, an associated .tcsv file is
saved for accelerated loading of data into the data
viewer. Do not move or delete any files from the com-
mon folder. Please find more information in the section 
File Format.

File Path: Select the Output File location

File Name: Choose the file name

Saving Interval: Set the time interval between saved
data points. The minimal interval is one second.
Choose the Delimiter for easy access and analysis of
your saved data. 

Stop Condition: Select the criteria for terminating the
logging process. 

o Size: Measure up to a file size of 99 999 MB. Approx-
imation of the file size: 100 samples of one parameter
of one power meter require ~ 4kb disc space. The re-
quired disc space is not strictly linear. To log measure-
ments > 99 999 MB, choose either the stop condition
"Duration" or "Manual".

oDuration: Measure for a certain duration

oNumber of Samples: Measure a set number of
samples

oManual: Stop logging manually  

 Note 

Logging can not be started if no parameters were selected in the Table Settings. 

 Attention 

General settings in the Settings panel can be changed even during a logged long-term meas-
urement. Changes will be applied immediately but the changes in the settings will not be saved
in the logged file. Please note such changes, as evaluation of such data may otherwise be
complicated. 

 Attention 

Disable hibernation and sleep mode of the PC. Otherwise, the PC looses the connection to the
monitored devices, the measurement stops, and the OPM software may freeze when entering
sleep mode or hibernation.

Start Logging

Click this button to start logging of the measurement. If the file name was already used, a warn-
ing window appears. 
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The Logging Settings panel will change to the Logging Information panel and show the status
of the measurement. 
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4.3.3   Logging Chart

The Logging Chart displays the logged data over time. Use the Tool Bar to set up the display
and analyze the data. The Logging information panel displays the progress of the measure-
ment.

Tool Bar 

 Settings   

To configure the chart display settings in the real-time measurement, choose any parameter
and device (Displayed Devices) selected in the monitoring Table. Assign different colors to
easily distinguish power meters and parameters in the display. Enable a second chart by mov-
ing the toggle switch in Chart 2 to Enabled.
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Click Ok to set the selection.

 Note 

If parameters or devices do not appear for selection, they were not selected in the Table menu.
To add them, click "Stop Logging" in the Logging Information panel, go to the Table menu
on the left side of the display, add the desired devices and parameters and Start Logging in
the Logging Information panel.

Zoom: To zoom into the chart, place the mouse pointer over the chart and scroll.

 Zoom out: Zooms out to the original resolution in both, the X and Y axis. 

 Zoom out Y-Axis: Zooms out to the original resolution in the Y axis only.   

 Enable/Disable Legend: Add the legend listing the used devices to the chart area as
shown above

 Enable/Disable Marker: Add the marker to display the measurement value at a
chosen single time point next to the chart. 

Zoom selection: Zoom into the region of interest (ROI) by selecting the area. You
can then move a window of the size of the ROI through the whole chart area. Click 

 for the chart to resume the original resolution.

4.3.4   File Format

The user can record and save data in different formats, depending on the size of the measure-
ment data. 

1) Small Data Volumes

All data saved in the Statistics or Graph panel are saved as .csv files. Choose this setting to
save data than can easily be opened in a text editor without reaching the line limit of about 1
million lines. This format can be opened in a text editor, but can not be loaded into the Data
Viewer.

Data recorded in the Monitoring panel when choosing to save as single file only are also saved
as .csv files. These data can be opened in the Data Viewer or in a text editor.  
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2) Large Data Volumes

All data saved in the Monitoring panel when choosing to save as "multiple files" are saved as
mulitple .csv files with an associated .tcsv file in the same folder. 

The .tcsv files are compressed files of the associated .csv files for fast loading into the Data
Viewer. For high resolution viewing in the data viewer, the .csv files are required to be in the
same location as the .tcsv file. The uncompressed .csv files carry the name: filename_Raw#.

The log-file in .tcsv format saves the following data:

· Device Information (Power Meter and Sensor with Serial Numbers)
· Values of the Selected Devices and Parameters, Saved with the Selected Sampling Inter-

val (Sorted by Sample Number, Date and Time down to Seconds)
· Wavelength

 Note  

DO NOT delete, move or rename the uncompressed .csv files in the .tcsv file folder, because
the uncompressed files are required for high resolution viewing in the data Data Viewer.
However, the uncompressed "raw" csv files can be used in your own analysis software. To do
this, please copy the desired files first to a location different from the original location.

PM400 .csv Format

To load data saved by the PM400 into the Data Viewer of the OPM, go to the File Menu and
choose Load PM400 File. 

4.4   Data Viewer

Data logged by the OPM can be loaded and displayed in the Data Viewer. 

Loading Data:

To load data into the Data Viewer, go to File and select Load to open the file of interest.

The loaded data are displayed as a list of Devices, the Data Chart of data points over time and
the Logging Information.
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Devices:

The Devices menu lists the power meters and sensors that were used in the loaded measure-
ment.

First Device: Name as Set in Edit Devices  ®
Type of the Power Meter  ®

Serial Number of the Power Meter  ®

Type of the Sensor  ®

Serial Number of the Sensor  ®

Wavelength Analyzed in the Optical Setup  ®

Second Device: Name as Set in Edit Device  ®

Go to the Data Chart and use the Tool Bar to configure the display of devices and paramet-
ers. 



© 2018 Thorlabs GmbH

4 Graphical User Interface (GUI)

33

Data Chart:

The Data Chart displays the loaded data over time. The display optionally includes a legend for
the monitored devices and a cursor to choose the display of a specific measurement value. Use
the Tool Bar on top of the chart to edit the display and analyze the data set.
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Tool Bar

 Settings: 

To analyze the measurement, add any parameter and device (Displayed Devices) of the loaded
file to the Data Chart. Assign different colors to easily distinguish power meters and paramet-
ers in the display. Move the toggle switch in Chart 2 to Enabled to display the second chart.

Click OK when the selection is finished. 

Zoom: To zoom into the chart, place the cursor over the chart and scroll.

Zoom out: Zooms out to the original resolution in both, the X and Y axis. 

Zoom out Y-axis: Zooms out to the original resolution in the Y axis only.   

Enable/Disable Legend: Add the legend listing the used devices to the chart area as
shown above.

 Enable/Disable Marker: Add the marker to display the measurement value at a chosen
single time point next to the chart. 
Zoom Selection: Zoom into a ROI by selecting the area. The user can then move a win-
dow of the size of the ROI through the whole chart area. 
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Zoom Selection:
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4.5   Help

Change language settings, open the manual as online help (.chm file) or .pdf, get access to the
log-file, open the license, and get information on the software version here. 

Please feel free to check for updates frequently. 
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5   Optical Power Monitor with Different Devices
The Optical Power Monitor automatically responds to the functional differences of connected
devices and adjusts the interface with the additional options.

This chapter describes these differences and additional options with respect to different power
meter consoles and/or sensors compared to the example settings with a PM100USB and a
Photodiode Power Sensor S120VC.

5.1   Power Meter Dependent Variations

5.1.1   PM16/PM160

When using the power meters PM16 or PM160, the measurement range adjusts automatically,
not manually, and the attenuation can not be set in the settings panel.

5.2   Sensor-Dependent Variations

5.2.1   Pyroelectric Energy Sensors ESxxxC

The Thorlabs ESxxxC Pyroelectric Sensors are designed to measure pulsed coherent and inco-
herent sources. Pyroelectric sensors convert energy from light pulses into voltage pulses.

Because in this case the measured light signal is not continuous, the OPM requires different
settings for processing and display. 

Find below the relevant changes in the OPM when using a pyroelectric energy sensor, de-
scribed for a setup using a ES111C pyroelectric sensor connected to a PM100D power meter.

The interface looks the following way:

https://www.thorlabs.com/newgrouppage9.cfm?objectgroup_id=4037
https://www.thorlabs.com/newgrouppage9.cfm?objectgroup_id=3328&pn=S120VC#3329
https://www.thorlabs.com/search/thorsearch.cfm?search=PM16
https://www.thorlabs.com/search/thorsearch.cfm?search=PM160
https://www.thorlabs.de/newgrouppage9.cfm?objectgroup_id=3337
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1. Settings Menu 

The list of settings differs in the following:

Parameter: Energy and Fluence are parameters of choice instead of Power
and Irradiance as Energy and Fluence are calculated independent of time.

Range: Auto Range is not available when using a pyroelectric sensor because
this can not be accommodated with pulsed signals.

2. Measurement Menu: Add/Remove Parameters  

For pyroelectric sensors, the measurement interface additionally displays the AD Saturation in
a bar, as shown on the previous page.

When selecting  , the available parameters now list Energy, Fluence and Average Power.

Average Power: The Average Power is calculated as an average of 3 measurement values.
The calculation of the measurement values is based on the set Averaging.

When Averaging is set to 1, each signal pulse results in one measurement value. Since this is
a rolling average, the second value of the average power is calculated using the pulse signals 2
to 4 and so on. 

When Averaging is set to 2, the average of pulse 1 and 2 generates the first measurement
value. The average of pulse 2 and 3 gives the second measurement value and so on. As
above, the average power is calculated as the average of measurement values 1-3 calculated
from signal pulses 1-4. Since this is a rolling average, the second average power value is calcu-
lated using signal pulse 2 to 5 and so on.
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3. Graph Menu

For pulsed laser applications, the Graph panel changes from a line-display, as shown for con-
tinuous signal, to a bar graph.

4. Monitoring Menu

Table configuration

For pyroelectric sensors, the Table Configuration now additionally lists the parameters Energy,
Fluence and Average Power that can to be logged in the experiment and continuously dis-
played. 
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5. Logging Chart

Corresponding to the parameters selected in the above Table Configuration, the additional
parameters can be selected for display in the Logging Chart.

The Logging Chart displays the pulse energy values in a continuous line. Please adjust the
saving interval according to the interval between the laser pulses in your setup to avoid data
points without signal. For pulse intervals shorter than the saving interval, the displayed value is
the last value sent by the power meter. For higher resolution measurements, please use the 
Graph mode.
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5.2.2   Temperature Sensor TSP-TH on PM400

Temperature can be recorded by the Optical Power Monitor if a Thorlabs Temperature Sensor
TSP-TH is attached to a PM400 in addition to any Thorlabs C-Series sensor. Please see the
PM400 Manual for more details.  

This section describes the additional options available in the software when a temperature
sensor is recognized.

1. Settings Menu

Specify the following Temperature Sensor settings. 

R25: Resistance @ 25 °C in Ohm [W]

B: NTC-Constant (NTC: Negative Temperature Coefficient) [K]

To find the appropriate parameters, please see the specifications of
the Temperature Sensor.

2. Measurement Menu: Add/Remove Parameters

For temperature sensors, the parameters list temperature in °C and °F, when selecting .

3. Monitoring Menu

When using a temperature sensor, the temperature in °C and °F can be logged and monitored
by adding these parameters in the Table Configuration panel.

https://www.thorlabs.com/search/thorsearch.cfm?search=TSP-TH
https://www.thorlabs.com/thorproduct.cfm?partnumber=PM400
https://www.thorlabs.com/newgrouppage9.cfm?objectgroup_id=3328
https://www.thorlabs.com/drawings/ff546dc7ce18eb48-B979078E-0FCB-5845-EEC8BB07477B5BDD/PM400-Manual.pdf
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6   Version Information
For information on the software version, please go to the Help menu.
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7   Instrument Driver for Thorlabs Power Meters
The Thorlabs Optical Power Monitor (OPM) uses a new driver for the connected power meters.

· Formerly used driver: NI-VISA™-based driver PM100D.dll.
· OPM software power meter driver: TLPM.dll.

The new driver TLPM.dll is automatically installed with the OPM installation. We recommend
using this driver as it is easier to install, uses less disk space and has a more robust algorithm
for recognizing devices than the previously used NI-VISA™-based driver PM100D.dll. 

 Attention 

Custom Made Software

Be aware that the driver assignment of the power meters is changed upon installation of the
OPM. If you created your own software for remote operation of Thorlabs power meters based
on the PM100D.dll driver, the software needs to be modified to use the new TLPM.dll driver.
Please read the chapters Adaptation of Customer Software and Write Your Own Application
(WYOA) for instructions.

Alternatively, you can use the tool Power Meter Driver Switcher to switch between the two
drivers, the PM100D.dll driver and the new TLPM.dll driver, according to your needs. The 
Power Meter Driver Switcher, is installed together with the Optical Power Monitor.  

 Attention 

Power Meter Monitor, Optical Power Meter Utility and Multi Power Meter

To keep using the software packages Power Meter Monitor, Optical Power Meter Utility or
Multi Power Meter software after installing the Optical Power Monitor with the TLPM.dll driver,
the user needs to revert to the driver PM100D.dll. To switch between the old PM100D.dll driver
and the new TLPM.dll driver, a software tool, the Power Meter Driver Switcher, is installed to-
gether with the Optical Power Monitor. 

7.1   Power Meter Driver Switcher

The Power Meter Driver Switcher is a tool to switch between the NI-VISA™-based PM100D.dll
driver and the TLPM.dll driver installed with the Optical Power Monitor in cases listed above. 

 Attention 

To use the Power Meter Driver Switcher and change instrument drivers, you need administrator
rights on your PC. 

The Power Meter Driver Switcher tool can be opened as a separate tool (a) or from within the
OPM software (b).

a) Open Power Meter Driver Switcher as a Seperate Tool

You can either open the Power Meter Driver Switcher through the Start button or from the Pro-
gram Folder:

· Start Button: 
All programs > Thorlabs > Power Meter > Tools > Power Meter Driver Switcher
· Program folder:
C:\Program File (x86)\Thorlabs\PowerMeters\Tools\DriverSwitcher

 Attention 
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To use the Power Meter Driver Switcher and change instrument drivers, you need administrator
rights on your PC. 

b) Open Power Meter Driver Switcher inside OPM

This is only possible when devices with the driver PM100D.dll are found. 

· go to the panel Devices, 

· click  Add devices and 
· click Open Power Meter Driver Switcher on the bottom of the interface

The Power Meter Driver Switcher opens with the following interface:

Use the Menu Bar at the bottom, to Rescan and see all attached devices. The table lists the
Type of instrument, its Serial Number and the currently installed Driver.

You can now convert the drivers for all or the selected devices to the driver appropriate for your
application. 
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 Note 

Use the PM100D.dll for the Power Meter Monitor, Optical Power Meter Utility, or Multi Power
Meter software.

Use the TLPM.dll for the Optical Power Monitor.

The Help panel guides you to the Thorlabs website, the license agreement, and the software
version number. 

Close the Power Meter Driver Switcher after the driver exchange to prevent unintentional use. 

 Note 

You can use the different drivers for different devices in parallel. Example: Power Meter
PM100USB SerialNumber 1 and Power Meter PM100USB SerialNumber 2 are both connected
to the PC. You can now use PM100USB SerialNumber 1 with driver TLPM.dll in the Optical
Power Monitor and PM100USB SerialNumber 2 with the driver PM100D.dll using another soft-
ware in parallel. 
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7.2   Adaptation of Customer Software

The driver assignment of the power meters is changed upon installation of the OPM. If you cre-
ated your own software for remote operation of Thorlabs power meters based on the
PM100D.dll driver, the software needs to be modified to use the new TLPM.dll driver.

Alternatively, you can use the tool Power Meter Driver Switcher to switch between the two
drivers, the PM100D.dll driver and the new TLPM.dll driver, according to your needs. The 
Power Meter Driver Switcher, is installed together with the Optical Power Monitor.  

Instruction to switch to the new TLPM driver:

1. Replace the Header files in the project:
PM100D implementation:

#include "visa.h"

#include "PM100D.h"

® TLPM Implementation:

#include "TLvisa.h"

#include "TLPM.h"

2. Replace the prefix of all functions and defines PM100D_ ® TLPM_

E.g.: 

PM100D_init ® TLPM_init

PM100D_ATTR_SET_VAL ® TLPM_ATTR_SET_VAL

3. Add the library TLPM_32.lib to the project

In the project settings add “TLPM_32.lib” to the project.

4. Be sure that the library “TLPM_32.dll” is either beside the application, in the path of the
environment variable VXIPNPPATH or PATH or in the system folder. Use the same loca-
tion as the PM100D_32.dll.
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8   Troubleshooting

· Devices with Incompatible Instrument Drivers

Ø Reason: The Thorlabs Optical Power Monitor (OPM) uses a different driver for the con-
nected power meters than former Thorlabs power meter software applications (Power
Meter Monitor, Optical Power Meter Utility or Multi Power Meter). That is why a driver may
be incompatible.  

Former instrument driver: NI-VISA™-based driver PM100D.dll.
OPM instrument driver: TLPM.dll.

Ø Solution: To switch between the PM100D.dll and the TLPM.dll, use the Power Meter
Driver Switcher tool. Read about the different instrument drivers in the section Instrument
Driver for Thorlabs Power Meters. 

· I can not use the software Power Meter Monitor 

Ø Reason: The Thorlabs Optical Power Monitor (OPM) uses a different driver for the con-
nected power meters than the Thorlabs Power Meter Monitor. The instrument driver of the
power meters was changed to the new driver upon installation of the Optical Power Mon-
itor. That is why a driver may be incompatible. 

Former instrument driver: NI-VISA™-based driver PM100D.dll.
OPM instrument driver: TLPM.dll.

Ø Solution: To revert to the PM100D.dll, use the Power Meter Driver Switcher tool supplied
with the Optical Power Monitor software package. Read about the different instrument
drivers in the section Instrument Driver for Thorlabs Power Meters. 

· I can not use the software Optical Power Meter Utility

Ø Reason: The Thorlabs Optical Power Monitor (OPM) uses a different driver for the con-
nected power meters than Thorlabs power meter software application Optical Power
Meter Utility. The instrument driver of the power meters was changed to the new driver
upon installation of the Optical Power Monitor. That is why a driver may be incompatible. 

Former instrument driver: NI-VISA™-based driver PM100D.dll.
OPM instrument driver: TLPM.dll.

Ø Solution: To revert to the PM100D.dll, use the Power Meter Driver Switcher tool supplied
with the Optical Power Monitor software package. Read about the different instrument
drivers in the section Instrument Driver for Thorlabs Power Meters. 

· I can not use the software Multi Power Meter

Ø Reason: The Thorlabs Optical Power Monitor (OPM) uses a different driver for the con-
nected power meters than Thorlabs power meter software application Multi Power Meter.
The instrument driver of the power meters was changed to the new driver upon installa-
tion of the Optical Power Monitor. That is why a driver may be incompatible. 

Former instrument driver: NI-VISA™-based driver PM100D.dll.
OPM instrument driver: TLPM.dll.

Ø Solution: To revert to the PM100D.dll, use the Power Meter Driver Switcher tool supplied
with the Optical Power Monitor software package. Read about the different instrument
drivers in the section Instrument Driver for Thorlabs Power Meters. 
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· I can not use my Custom Made Software to steer Thorlabs power meters anymore

Ø Reason: The Thorlabs Optical Power Monitor (OPM) uses a different driver for the con-
nected power meters than former Thorlabs power meter software applications. The instru-
ment driver of the power meters was changed to the new driver upon installation of the
Optical Power Monitor. You may have used the former instrument driver when writing your
software and now that the driver is changed, your software no longer recognizes the
power meters. 

Former instrument driver: NI-VISA™-based driver PM100D.dll.
OPM instrument driver: TLPM.dll.

Ø Solution: You can either adjust your custom made software or switch between the
PM100D.dll and the TLPM.dll by using the Power Meter Driver Switcher tool supplied with
the Optical Power Monitor software package. Read about the different instrument drivers
in the section Instrument Driver for Thorlabs Power Meters. 

· The PC freezes/ OPM freezes when logging a long term experiment

Ø Reason: When logging a long-term measurement, the PC may go into hibernation or
sleep mode. This causes the Optical Power Monitor to loose contact to the power meters
and results in freezing of the Optical Power Monitor

Ø Solution: Turn off hibernation and sleep settings on your PC for long-term experiments
read the section Logging Configuration.
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9   Write Your Own Application

In order to write your own application, you need a specific instrument driver and some tools for
use in different programming environments. The driver and tools are being installed to your
computer during software installation and cannot be found in the installation package.

In this section the location of drivers and files, required for programming in different environ-
ments, are given for installation under Windows® 7, Windows® 8.1 and Windows® 10 (32 and
64-bit).

In order to fully support 64-bit LabVIEWä version, the installation offers two installer versions: 

· For Windows® 7 (32/64 bit), Windows® 8.x (32/64 bit) and Windows® 10 (32/64 bit): Install
"xxxx VXIpnp Instrument Driver (32bit)"

· For Windows® 7 (64 bit), Windows® 8.x (64 bit) and Windows® 10 (64 bit): Install "xxxx 
VXIpnp Instrument Driver (64 bit)"

In other words, the 32-bit VXIpnp driver works with both 32 and 64-bit operating systems, while
the 64 bit driver requires a 64 bit operating system.

 Note 

The Thorlabs Optical Power Meter software and drivers contains 32 bit and 64 bit applications. 

In  32 bit systems, only the 32 bit components are installed to 

C:\Program Files\...  

In 64 bit systems the 64 bit components are being installed to

C:\Program Files\...

while 32 bit components can be found at

C:\Program Files (x86)\...

In the table below you will find a summary of what files you need for particular programming en-
vironments.

Programming environment Necessary files

C, C++, CVI *.h (header file)
*.lib (static library)

C# .net wrapper dll

Visual Studio *.h (header file)
*.lib (static library)
or 
.net wrapper dll

LabVIEWä *.fp (function panel) and VXIpnp Instrument Driver.
Beside that, LabVIEWä driver vi's are provided with the *.llb
container file

 Note 

All above environments require also the VXIpnp Instrument Driver dll!

During Runtime installation, a system environment variable VXIPNPPATH for including files is
created. It contains the information where the drivers are installed to, usually to C:\Program
Files\IVI Foundation\VISA\WinNT\.

This environment variable is necessary for installation of the instrument driver software com-
ponents.

In the next sections the locations of above files are described in detail.
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9.1   32-bit Operating System

 Note 

According to the VPP6 (Rev6.1) Standard the installation of the 32 bit VXIpnp driver includes
both the WINNT and GWINNT frameworks.

VXIpnp Instrument Driver:

C:\Program Files\IVI Foundation\VISA\WinNT\Bin\TLPM_32.dll

 Note  

This instrument driver is required for all development environments!

Header File

C:\Program Files\IVI Foundation\VISA\WinNT\include\TLPM.h

Static Library

C:\Program Files\IVI Foundation\VISA\WinNT\lib\msc\TLPM_32.lib

Function Panel

C:\Program Files\IVI Foundation\VISA\WinNT\TLPM\TLPM.fp

Online Help for VXIpnp Instrument Driver:

C:\Program Files\IVI Foundation\VISA\WinNT\TLPM\Manual\TLPM.html

NI  LabVIEWä Driver

The LabVIEWä Driver is a 32 bit driver and compatible with 32 bit NI-LabVIEWä versions 8.5
and higher up to versions 2014.

C:\Program Files\National Instruments\LabVIEW xxxx\Instr.lib\TLPM…
…\TLPM.llb 

(LabVIEWä container file with driver vi's and an example. "LabVIEW xxxx" stands for actual
LabVIEWä installation folder.) 
In case LabVIEW™ is not installed or if LabVIEW™ versions 2017 and higher are installed, the
LabVIEW™ driver will be installed in:

C:\Program Files\Thorlabs\PowerMeters\LabVIEW\LabVIEW 32bit\TLPM.llb 

.net wrapper dll

C:\Program Files\Microsoft.NET\Primary Interop Assemblies…
…\ Thorlabs.TLPM_32.Interop.dll

C:\Program Files\IVI Foundation\VISA\VisaCom\…
…\Primary Interop Assemblies\ Thorlabs.TLPM_32.Interop.dll

Example for C

Source file:

C:\Program Files\IVI Foundation\VISA\WinNT\TLPM\Example\C\…
…sample.c
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Example for C++

Solution file:

C:\Program Files\IVI Foundation\VISA\WinNT\TLPM\Example\…
…MS_VCpp\thorlabs_tlpm_sample.sln

Project file:

C:\Program Files\IVI Foundation\VISA\WinNT\TLPM\Example\…
…MS_VCpp\thorlabs_tlpm_sample.vcproj

Example for C#

Solution file:

C:\Program Files\IVI Foundation\VISA\WinNT\TLPM\Example…
…\MS.NET_CS\ Thorlabs.TLPM.Interop.Sample.sln

Project file:

C:\Program Files\IVI Foundation\VISA\WinNT\TLPM\Examples…
…\MS.NET_CS\Thorlabs.TLPM.Interop.Sample\ Thorlabs.TLPM.In-
terop.Sample.csproj

Example for LabVIEWä
C:\Program Files\National Instruments\LabVIEW xxxx\Instr.lib\TLPM…
…\TLPM.llb 

(LabVIEWä container file with driver vi's and an example. "LabVIEWä xxxx" stands for actual
LabVIEWä installation folder.) 

9.2   64-bit Operating System

 Note 

According to the VPP6 (Rev6.1) Standard the installation of the 64 bit VXIpnp driver includes
the WINNT, WIN64, GWINNT and GWIN64 frameworks. That means, that the 64 bit driver in-
cludes the 32 bit driver as well. 

In case of a 64 bit operating system, 64 bit drivers and applications are installed to 

“C:\Program Files” 

while the 32 bit files - to  

“C:\Program Files (x86)” 

Below are listed both installation locations, so far applicable.

VXIpnp Instrument Driver:

C:\Program Files (x86)\IVI Foundation\VISA\WinNT\Bin\TLPM_32.dll

C:\Program Files\IVI Foundation\VISA\Win64\Bin\TLPM_64.dll

 Note 

This instrument driver is required for all development environments!

Header File

C:\Program Files (x86)\IVI Foundation\VISA\WinNT\include\TLPM.h

C:\Program Files\IVI Foundation\VISA\Win64\include\TLPM.h
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Static Library

C:\Program Files (x86)\IVI Foundation\VISA\WinNT\lib\msc...
...\TLPM_32.lib

C:\Program Files\IVI Foundation\VISA\Win64\lib\msc\TLPM_32.lib

C:\Program Files\IVI Foundation\VISA\Win64\Lib_x64\msc\TLPM_64.lib

Function Panel

C:\Program Files (x86)\IVI Foundation\VISA\WinNT\TLPM\TLPM.fp

Online Help for VXIpnp Instrument Driver:

C:\Program Files (x86)\IVI Foundation\VISA\WinNT\TLPM\Manual\TLPM.html

NI LabVIEWä Driver

The LabVIEWä driver supports 32 bit and 64 bit NI-LabVIEWä 2009 and higher up to versions
2014.

C:\Program Files\National Instruments\LabVIEW xxxx\Instr.lib\TLPM …
…\TLPM.llb

(LabVIEWä container file with driver vi's and an example. "LabVIEW xxxx" stands for actual
LabVIEWä installation folder.) 

In case LabVIEW™ is not installed or if LabVIEW™ versions 2017 and higher are installed, the
LabVIEW™ driver will be installed in:

C:\Program Files\Thorlabs\PowerMeters\LabVIEW\LabVIEW 64bit\TLPM.llb

.net wrapper dll

C:\Program Files (x86)\Microsoft.NET\Primary Interop Assemblies…
…\ Thorlabs.TLPM_32.Interop.dll

C:\Program Files (x86)\IVI Foundation\VISA\VisaCom\…
…\Primary Interop Assemblies\ Thorlabs.TLPM_32.Interop.dll

C:\Program Files\IVI Foundation\VISA\VisaCom64\…
…\Primary Interop Assemblies\ Thorlabs.TLPM_64.Interop.dll

Example for C

Source file:

C:\Program Files (x86)\IVI Foundation\VISA\WinNT\TLPM\Example\C\…
…sample.c

Example for C++

Solution file:

C:\Program Files (x86)\IVI Foundation\VISA\WinNT\TLPM\Example\…
…MS_VCpp\thorlabs_tlpm_sample.sln

Project file:

C:\Program Files (x86)\IVI Foundation\VISA\WinNT\TLPM\Example\…
…MS_VCpp\thorlabs_tlpm_sample.vcproj
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Example for C#

Solution file:

C:\Program Files (x86)\IVI Foundation\VISA\WinNT\TLPM\Example…
…\MS.NET_CS\ Thorlabs.TLPM.Interop.Sample.sln

Project file:

C:\Program Files (x86)\IVI Foundation\VISA\WinNT\TLPM\Examples…
…\MS.NET_CS\Thorlabs.TLPM.Interop.Sample\ Thorlabs.TLPM.In-
terop.Sample.csproj

Example for LabVIEWä
C:\Program Files (x86)\National Instruments\LabVIEW xxxx\In-
str.lib\TLPM…
…\TLPM.llb 

 (LabVIEWä container file with driver vi's and an example. "LabVIEW xxxx" stands for actual
LabVIEWä installation folder.) 
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10   Appendix

10.1   Warranty

Thorlabs GmbH warrants the hard- and/or software determined by Thorlabs GmbH for this unit
to operate fault-free provided that they are handled according to our requirements. However,
Thorlabs GmbH does not warrant a fault free and uninterrupted operation of the unit, of the
software or firmware for special applications nor this instruction manual to be error free. Thor-
labs GmbH is not liable for consequential damages.

Restriction of Warranty

The warranty mentioned before does not cover errors and defects being the result of improper
treatment, software or interface not supplied by us, modification, misuse or operation outside
the defined ambient stated by us or unauthorized maintenance.

Further claims will not be consented to and will not be acknowledged. Thorlabs GmbH does ex-
plicitly not warrant the usability or the economical use for certain cases of application. 

Thorlabs GmbH reserves the right to change this instruction manual or the technical data of the
described unit at any time. 

10.2   Copyright and Exclusion of Reliability

Thorlabs GmbH has taken every possible care in preparing this document. We however as-
sume no liability for the content, completeness or quality of the information contained therein.
The content of this document is regularly updated and adapted to reflect the current status of
the hardware and/or software. We furthermore do not guarantee that this product will function
without errors, even if the stated specifications are adhered to.

Under no circumstances can we guarantee that a particular objective can be achieved with the
purchase of this product.

Insofar as permitted under statutory regulations, we assume no liability for direct damage, indir-
ect damage or damages suffered by third parties resulting from the purchase of this product. In
no event shall any liability exceed the purchase price of the product.

Please note that the content of this document is neither part of any previous or existing agree-
ment, promise, representation or legal relationship, nor an alteration or amendment thereof. All
obligations of Thorlabs GmbH result from the respective contract of sale, which also includes
the complete and exclusively applicable warranty regulations. These contractual warranty regu-
lations are neither extended nor limited by the information contained in this document. Should
you require further information on this product, or encounter specific problems that are not dis-
cussed in sufficient detail in the document, please contact your local Thorlabs GmbH dealer or
system installer.

All rights reserved. This document may not be reproduced, transmitted or translated to another
language, either as a whole or in parts, without the prior written permission of Thorlabs GmbH.

Copyright © Thorlabs GmbH 2018. All rights reserved.
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10.3   Thorlabs Worldwide Contacts

USA, Canada, and South America

Thorlabs, Inc.
56 Sparta Avenue
Newton, NJ 07860
USA
Tel: 973-300-3000
Fax: 973-300-3600
www.thorlabs.com
www.thorlabs.us (West Coast)
Email: sales@thorlabs.com
Support: techsupport@thorlabs.com

UK and Ireland
Thorlabs Ltd.
1 Saint Thomas Place, Ely
Cambridgeshire CB7 4EX
United Kingdom 
Tel:  +44-1353-654440
Fax: +44-1353-654444
www.thorlabs.com
Email: sales.uk@thorlabs.com
Support: techsupport.uk@thorlabs.com

Europe
Thorlabs GmbH
Hans-Böckler-Str. 6
85221 Dachau
Germany
Tel:  +49-8131-5956-0
Fax: +49-8131-5956-99
www.thorlabs.de
Email: europe@thorlabs.com

Scandinavia
Thorlabs Sweden AB
Bergfotsgatan 7
431 35 Mölndal
Sweden
Tel:  +46-31-733-30-00
Fax: +46-31-703-40-45
www.thorlabs.com
Email: scandinavia@thorlabs.com

France
Thorlabs SAS
109, rue des Côtes
78600 Maisons-Laffitte
France
Tel:  +33-970 444 844
Fax: +33-825 744 800
www.thorlabs.com
Email: sales.fr@thorlabs.com

Brazil
Thorlabs Vendas de Fotônicos Ltda.
Rua Riachuelo, 171
São Carlos, SP 13560-110
Brazil
Tel: +55-16-3413 7062
Fax: +55-16-3413 7064
www.thorlabs.com
Email: brasil@thorlabs.com

Japan
Thorlabs Japan, Inc.
Higashi Ikebukuro
Q Building 2nd Floor 2-23-2
Toshima-ku, Tokyo 170-0013
Japan
Tel:  +81-3-5979-8889
Fax: +81-3-5979-7285
www.thorlabs.jp
Email: sales@thorlabs.jp

China
Thorlabs China
Room A101, No. 100
Lane 2891, South Qilianshan Road
Putuo District
Shanghai 200331
China
Tel:  +86-21-60561122
Fax: +86-21-32513480
www.thorlabs.com
Email: chinasales@thorlabs.com

http://www.thorlabs.com
http://www.thorlabs.us
mailto:sales@thorlabs.com
mailto:techsupport@thorlabs.com
http://www.thorlabs.com
mailto:sales.uk@thorlabs.com
mailto:techsupport.uk@thorlabs.com
http://www.thorlabs.de
mailto:europe@thorlabs.com
http://www.thorlabs.com
mailto:scandinavia@thorlabs.com
http://www.thorlabs.com
mailto:sales.fr@thorlabs.com
http://www.thorlabs.com
mailto:brasil@thorlabs.com
http://www.thorlabs.jp
mailto:sales@thorlabs.jp
http://www.thorlabs.com
mailto:chinasales@thorlabs.com
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